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Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions.
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previously published material. Specifications and price change privileges reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

Planar Crown is a registered trademark of Aeroflex Inc.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.


http://www.tektronix.com/contact

Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; ¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category Il IlI, or IV circuits.

Power disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.
Replace batteries properly. Replace batteries only with the specified type and rating.

Use proper fuse. Use only the fuse type and rating specified for this product.

Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.

Provide proper ventilation. Refer to the manual's installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in This Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product

These terms may appear on the product:

= DANGER indicates an injury hazard immediately accessible as you read the marking.

= WARNING indicates an injury hazard not immediately accessible as you read the marking.
= CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:

A @ + b

CAUTION Protective Ground X
RefertoManual ~ (Earth) Terminal ~ Chassis Ground  Standby
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Compliance Information

Compliance Information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1:2006, EN 61326-2-1:2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 1234

= CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
= |EC 61000-4-2:2001. Electrostatic discharge immunity

B |EC 61000-4-3:2002. RF electromagnetic field immunity 3

= |EC 61000-4-4:2004. Electrical fast transient/burst immunity

B |EC 61000-4-5:2001. Power line surge immunity

® |EC 61000-4-6:2003. Conducted RF immunity ©

E |EC 61000-4-11:2004. Voltage dips and interruptions immunity 7

EN 61000-3-2:2006. AC power line harmonic emissions
EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.

4 Atthe IEC 61000-4-11 Voltage-Interruption Transient Immunity test at 0% for 250 cycles, the EUT reboots and can take greater
than 10 seconds to recover.

5 Performance degradation information for the IEC 61000-4-3 test: Residual spurious signals can typically increase to -55 dBm with
exposure to the disturbance levels of this test.

6  Performance degradation information for the IEC 61000-4-6 test: Residual spurious signals can typically increase to the worse of
either 55 dB below reference level or -75 dBm, with exposure to the disturbance levels of this test.

7 Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels
(IEC 61000-4-11).
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Compliance Information

Australia / New Zealand Declaration of Conformity — EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

®  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.

Australia / New Zealand contact.
Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

Safety Compliance
EC Declaration of Conformity — Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:
Low Voltage Directive 2006/95/EC.

= EN61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
= UL 61010-1:2004, 2nd Edition. Standard for electrical measuring and test equipment.

Canadian Certification

B CAN/CSA-C22.2 No. 61010-1:2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use. Part 1.

Additional Compliances

® |EC61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type

Test and measuring equipment.

Safety Class

Class 1 - grounded product.
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Compliance Information

Pollution Degree Description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

= Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

m Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

m  Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

B Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Environmental Considerations - RSA6100B

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling
Central Web page (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.
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Compliance Information

Environmental Considerations - RSA5100A

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling
Central Web page (www.eiae.org) for disposal or recycling information.

Perchlorate Materials. This product contains one or more type CR lithium coin cell batteries. According to the
state of California, CR lithium coin cells are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.
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Preface

Preface

This manual describes the installation and basic operation of the RSA6100B Series of Real-Time Signal Analyzers and
RSA5100A Series Real-Time Signal Analyzers. For more detailed information, see the online help for your instrument.

RSAG106B
RSA6114B
RSAG120B
RSA5103A
RSA5106A

Key Features

The RSA6100B Series and RSA5100A Series are a family of high-performance real-time signal analyzers. Key features
include:

Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault

DPX Density triggering to easily capture instabilities, transients and hidden signals that are impossible for other signal
analyzers to catch

Conventional spectrum analysis controls and functions including fast tuning, markers, phase noise, spurious and
other measurements

Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

Time domain triggering capability: Runt Triggers, Holdoff Trigger, and Time Qualification to all of the instrument triggers
(Standard on RSA6100B Series, Option 200 on RSA5100A Series)

Multi-domain displays that provide an intuitive understanding of time-varying RF signals

Conventional Vector Signal Analysis capability available (Option 21) with modulation analysis for >20 popular modulation
formats

Seamless capture of signals in up to 110 MHz spans (RSA6100B Series) or 85 MHz spans (RSA5100A Series)

RSA6100B Series & RSA5100A Series Quick Start User Manual



Preface

Documentation

The following documentation is available with your Tektronix RSA6100B Series or RSA5100A Series Signal Analyzers. For
the most current documentation, refer to the Tektronix Web site.

To read about

Use these documents

Installation and operation
(overviews)

Quick Start User Manual
The quick start user manual contains general information about how to put your instrument
into service and guides to user interface controls.

In-depth operation and
user interface help

Online help
The online help contains detailed information about how to operate the instrument.

Application examples

Application Examples Manual
This manual provides practical examples of using the analyzer to accomplish tasks.

Programming commands

Programmer Manual
This manual contains descriptions of programming commands and their use. This manual
is located in a PDF file located on the Documents CD.

Specifications and
performance verification

Specifications and Performance Verification Manual

This manual contains the instrument specifications and a procedure to check instrument
performance against warranted characteristics. This manual is in a PDF file located

on the Documents CD.

User service

Service Manual.

A manual that provides a list of replaceable parts, care and maintenance information, and
information for servicing the instrument to the module level. This manual is in a PDF file
located on the Product Documentation CD.

Software Upgrades

Software option upgrades are available. Software upgrades for options become operational only after you enter a valid
option key for the specific analyzer model and serial number.

To check for upgrades:

1. Use your Web browser to go to www.tektronix.com/software.

2. Enter the product name (for example RSA6120B or RSA5106A) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel

Step power

Connect Network PS2 SVGA USB
power

° DO OO O CE
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

RSA6100B Series Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), declassification and security instructions
(on CD), service manual (on CD), power cord, BNC-N adapter (RSA6106B and RSA6114B only, Tektronix part number
103-0045-XX), USB keyboard, USB mouse, and instrument front cover.

Documents

B RSA6100B Series and RSA5100A Series Real-Time Signal Analyzers Quick Start User Manual is available in the
following languages:

= English, Tektronix part number 071-2838-XX.

= Simplified Chinese, Tektronix part number 071-2839-XX.
= Japanese, Tektronix part number 071-2840-XX.

= Russian, Tektronix part number 071-2841-XX.

B RSA6100B Series and RSA5100A Series Product Documentation CD, Tektronix part number 063-4314-XX.
The Product Documentation CD contains PDF versions of the following manuals:

= RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User
Manual,
in English (this manual), Japanese, Russian and Simplified Chinese.

= RSAG6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Application Examples
Manual,
Tektronix part number 071-2834-XX.

= RSAG6100B Series Real-Time Signal Analyzers, Printable Online Help,
Tektronix part number 077-0519-XX.

= RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Programmer Manual,
Tektronix part number 077-0523-XX.

= RSA6100B Series Real-Time Signal Analyzers Service Manual,
Tektronix part number 077-0648-XX.

= RSA6100B Series Real-Time Signal Analyzers Specifications and Performance Verification Manual,
Tektronix part number 077-0647-XX.

= RSA6100B Series Real-Time Signal Analyzers Declassification and Security Instructions,
Tektronix part number 077-0521-XX.
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Installation

RF Input Connectors

The standard RF input connector on RSA6100B series instruments varies between models. The instruments use the Planar
Crown® Universal Connector System, which allows you to easily change the input connector if it is damaged or you need
to use a different connector type.

m RSA6106B: Planar Crown Type N connector, Tektronix part number 131-4329-00

= RSA6114B: Planar Crown Type N connector, Tektronix part number 131-4329-00

B RSA6120B: Planar Crown 3.5 mm connector, Tektronix part number 131-9062-00

Power Cords

The RSA6100B Series Real-Time Signal Analyzers are shipped with one of the following power cord options. Power cords
for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved by at
least one authority acceptable in the country to which the product is shipped.

International Power Plugs

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

A0 - North America power
A1 - Universal EURO power
A2 - United Kingdom power
A3 - Australia power

A4 - 240 V, North America power
A5 - Switzerland power

A6 - Japan power

A10 - China power

A11 - India power

A12 - Brazil power

A99 - No power cord

RSAB100B Series & RSA5100A Series Quick Start User Manual



Installation

RSA5100A Series Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), declassification and security instructions (on
CD), service manual (on CD), power cord, BNC-N adapter, USB keyboard, USB mouse, and instrument front cover.

Product Documentation

m  RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User Manual
is available in the following languages:

= English, Tektronix part number 071-2838-XX.

= Simplified Chinese, Tektronix part number 071-2839-XX.
= Japanese, Tektronix part number 071-2840-XX.

= Russian, Tektronix part number 071-2841-XX.

m  RSA6100B Series, RSA5100A Series Product Documentation CD, Tektronix part number 063-4314-XX.
The Product Documentation CD contains PDF versions of the following manuals:

= RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Quick Start User
Manual,
in English, Japanese, Russian and Simplified Chinese.

= RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Application Examples
Manual,
Tektronix part number 071-2834-XX.

= RSA5100A Series Real-Time Signal Analyzers, RSA6100B Series Real-Time Signal Analyzers Printable Online Help,
Tektronix part number 077-0519-XX.

= RSA6100B Series Real-Time Signal Analyzers, RSA5100A Series Real-Time Signal Analyzers Programmer Manual,
Tektronix part number 077-0523-XX.

= RSA5100A Series Real-Time Signal Analyzers Service Manual,
Tektronix part number 077-0522-XX.

= RSA5100A Series Real-Time Signal Analyzers Specifications and Performance Verification Manual,
Tektronix part number 077-0520-XX.

= RSA6100B Series and RSA5100A Series Real-Time Signal Analyzers Declassification and Security Instructions,
Tektronix part number 077-0521-XX.

Power Cords

The RSA5100A Series Real-Time Signal Analyzers are shipped with one of the following power cord options. Power cords
for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved by at
least one authority acceptable in the country to which the product is shipped.

International Power Plugs
®  Opt. AO - North America power
B Opt. A1 - Universal EURO power
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Installation

= Opt. A2 - United Kingdom power

B Opt. A3 - Australia power

m  Opt. Ad - 240V, North America power
B Opt. A5 - Switzerland power

= Opt. A6 - Japan power

®  Opt. A10 - China power

® Opt. A11 - India power

®  Opt. A12 - Brazil power

= Opt. A99 - No power cord

Optional Accessories

RSA6100B Series

= (65-0913-XX - Additional removable solid-state hard drive for use with Option 56
(Microsoft Windows 7 and instrument SW pre-installed)

®  Planar Crown 3.5 mm female connector, Tektronix part number 131-9062-00
B Planar Crown 3.5 mm male connector, Tektronix part number 131-8822-00
®  Planar Crown Type N female connector, Tektronix part number 131-4329-00

= Planar Crown SMA female connector, Tektronix part number 131-8689-00

RSA5100A

m  RTPA2A - Real-Time Spectrum Analyzer Probe Adapter; Supports TekConnect probes P7225, P7240, P7260, P7330,
P7313, P7350, P7350SMA, P7380, P7380SMA.

B RSAVu - Offline analysis software based on the RSA3000 platform for analysis supporting 3G wireless standards,
WLAN (IEEE 802.11a/b/g/n).

m  (65-0852-XX — Additional Removable Hard Drive for use with Opt. 56 (Windows 7 and instrument software pre-installed).
B Transit Case — Tektronix part number 016-1963-00.
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Installation

RSA6100B Series Options
You can add the following options to your analyzer:
= Option 10 - Adds Audio Analysis.
= QOption 11 - Adds Phase Noise and Jitter Measurement.
m  Option 12 - Adds Settling Time Measurement (Frequency and Phase).
B QOption 20 - Adds advanced signal analysis (including pulse measurements).
m  QOption 21 - Adds general-purpose digital modulation analysis.
= QOption 22 - Adds flexible OFDM analysis.
m  Option 50 - Adds 1 MHz to 6.2 GHz Pre-Amplifier.
B QOption 51 - Adds 100 kHz to 20 GHz Pre-Amplifier.
= Option 52 - Adds frequency mask triggering.
®  QOption 55 - Adds digital 1Q output and 500 MHz analog IF output.
= Option 56 - Adds a removable hard disk drive (not compatible with Option 57 or Option 59).
B Qption 57 - Adds a DVDxRW drive, no-cost option (not compatible with Option 56 or Option 59).
m  QOption 59- Adds a removable solid-state hard drive (not compatible with Option 56 or Option 57).
= QOption 110 - Adds 110 MHz real-time capture bandwidth.
B RSA56KR - Rackmount for RSA5100A Series and RSA6100B Series analyzers.
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Installation

RSA5100A Series Options
You can add the following options to your analyzer:
= Option 10 - Adds Audio Analysis.
= Option 11 - Adds Phase Noise and Jitter Measurement.
m  Option 12 - Adds Settling Time Measurement (Frequency and Phase).
B QOption 20 - Adds advanced signal analysis (including pulse measurements).
=m  Option 21 - Adds general-purpose digital modulation analysis.
®m  QOption 22 - Adds flexible OFDM analysis.
= Option 40 - Adds 40 MHz real-time capture bandwidth.
B QOption 85- Adds 85 MHz real-time capture bandwidth.
m  Option 50 - Adds 1 MHz to 3/6.2 GHz Pre-Amplifier.
®m  QOption 52 - Adds frequency mask triggering.
m  Option 53 - Adds Memory, 4 GB Acquisition Memory Total.
B QOption 56 - Adds a removable hard disk drive (not compatible with Option 57 or Option 59).
m  Option 57 - Adds a CD-R/W drive (not compatible with Option 56).
®m  QOption 59 - Adds a internal hard disk drive (not compatible with Option 56).
m  QOption 200 - Adds Advanced DPX with Density, Time Qualified and Runt Triggers and Zero-Span.

B QOption 5040 — Combines Option 50 (Preamp) and Option 40 (40 MHz Acquisition BW). Mutually exclusive with
Options 50 and 40.

®  Option 5085 — Combines Option 50 (Preamp) and Option 85(85 MHz Acquisition BW). Mutually exclusive with Options
50 and 40.

B RSA56KR - Rackmount for RSA5100A Series and RSA6100B Series analyzers.
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Operating Considerations

Power supply requirements

Source voltage and frequency

Installation

Power consumption

100 — 240 Vrys, 50/60 Hz
115 VRMS, 400 Hz

450 W maximum (all models)

Environmental requirements

Characteristic

Description

RSA6100B Series Operating temperature

+5 °C to +50 °C (+5 °C to +40 °C; when accessing the DVD drive or optional
removable hard-disk drive)

RSA5100A Series Operating temperature

+10 °C to +40 °C

Non-operating temperature

-20 °C to +60 °C

RSA6100B Humidity

90% relative humidity at 30 °C (non-condensing)
80% maximum when accessing the DVD drive
Maximum wet-bulb temperature 29 °C

RSA5100A Humidity 90% up to 30 °C (non-condensing)
80% relative humidity maximum when accessing the DVD drive
Above 30 °C it is limited by maximum wet-bulb temperature 29 °C
Altitude:
Operating Up to 3000 m (9843 ft)

Non-operating

12190 m (40,000 t)

Cooling clearance
Bottom
Sides and back

20 mm (0.79 in)
50 mm (1.97 in)

RSA6100B Series & RSA5100A Series Quick Start User Manual



Installation
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CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting

on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the signal analyzer. The instrument is heavy and

requires extra care when moving it.

Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with

USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘
network for printing, file sharing, Internet

access, and other functions. Consult your
network administrator and use the standard
Windows utilities to configure the instrument
for your network.

Quick Tip

2838016

= |f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing

regular approved operating system updates, and using up-to-date antivirus software.

2838015

8 RSA6100B Series & RSA5100A Series Quick Start User Manual



Installation

Powering On the Instrument
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U BB017

Powering Off the Instrument
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Removing the Power
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Installation

Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the analyzer and the second
monitor must have the color set to True Color.

1. Power off the analyzer and the external (
monitor.

ﬁ

2838018

2. Connect the external monitor to the

analyzer.
[eLe @ §
T ]
L /J—LQ
\ 5

2838020

3. Power on the analyzer and the external
monitor.

O
[ Een] ‘
| OO @ O[O \
! g Sy ! g
O O
» gooo0 S ST =»
jesleslanlen] o O
ocoooo O O
] b\

) 2638021
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4. Open the Windows Control Panel.

5. Double-click Intel(R) Graphics and
Media to open the Intel Graphics and
Media Control Panel.

6. Set the Display setting to Built-in
Display.

Installation

=

Adjust your computer’s settings

¥ Action Center

b Backup and Restore

[E Credential Manager

[ Desktop Gadgets

B8 Display

Folder Options

o HomeGroup

Internet Options

F Mouse

& Parental Controls

[ Phone and Modem

B Realtek HD Audio Manager

#5 RemoteApp and Desktop Connections
@) Sync Center

[ Troubleshooting

-]

dows Defender

Nindows Update

() [+ Control Panel + All Control Panel tems »

Administrative Tools

B BitLocker Drive Encryption
2 Date and Time
& Device Manager
@ Ease of Access Center
A Fonts
& Indexing Options
@2 Keyboard
5= Network and Sharing Center
M Performance Information and Tools
3B Power Options
il Recavery
% Sound

ystem
8 User Accounts

&

Yindows Firewall

'\‘1”

Viewby: Smallicons ¥

[=g AutoPlay

KX Color Management

@ Default Programs

# Devices and Printers

Fl Elo Touchscreen (32-bit)

5] Getting Started

B Intel(R) Graphics and Media
EZ Location and Other Sensors
2 Notification Area Icons

&l personalization

[ Programs and Features

# Region and Language

& Speech Recognition

ke Taskbar and Start Menu
B

[ Windows Mobility Center

dows CardSpace

| Display

(intel.
Intel®

Graphics and Media
Control Panel

General Settings
Multiple Displays
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

RSA6100B Series & RSA5100A Series Quick Start User Manual
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Color Depth

Refresh Rate

Scaling

Built-in Display

1024 x 768

32 Bit

Scale Full Screen

2838-064
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Installation

7. Click Multiple Displays.

8. Set the Operating Mode to Clone

Displays or Extended Displays as PR Uy

preferred . Graphics and Media Operating Mode | Clone Displays -
Control Panel
Single Display l:l

| Primary Display
Display E - .
—— EE o Dispiay + Clone Displays

General Settings

Multiple Displays (13 Extended Desktop l:i:l

Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

9. If you select Extended Desktop, be sure
to set the Positioning to align the two
desktop displays. Intel®

Graphics and Media Operating Mode  Extended Desktop
Control Panel

Primary Display  Built-in Display
| Display g"
——— Second Display ~ Monitor

General Settings

Multiple Displays

Multiple Displays L Positioning.
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support
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Installation

Adjusting the Windows Display Settings

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.
1. Open the Windows Control Panel. ==
(_J(.) =B » Control Panel » All Control Panelltems » v [ 43 ||| Search Controt Pane ol
2. Double-click Intel(R) Graphics and SO =l
Media to open the Intel Graphics and Adjust your computer’s settings Viewby: Smallicons ¥
Media Control Panel.
¥ Action Center 4] Administrative Tools i AutoPlay
W Backup and Restore B BitLocker Drive Encryption Bl Color Management
[ Credential Manager Y Date and Time @ Default Programs
& Deskiop Gadgets &4 Device Manager #5 Devices and Printers
B Display @ Ease of Access Center fIM Elo Touchscreen (32-bit)
E Folder Options A Fonts 4 Getting Started
& HomeGroup &% Indexing Options Intel(R) Graphics and Media
€1 Internet Options @2 Keyboard B Location and Other Sensors
# Mouse 5 Network and Sharing Center & Notification Area Icons
&5 Parental Controls M Performance Information and Tools B Persenalization
{5 Phone and Modem B Power Options [ Programs and Features
B Realtek HD Audic Manager & Recovery # Region and Language
™ RemoteApp and Desktop Connections % Sound & Speech Recagnition
@ Sync Center 18 System | Taskbar and Start Menu
& Troubleshooting 2, User Accounts B windows Cardspace
il Windows Defender P Windows Firewall 8 Windows Mobility Center
£} Windows Update

3. Adjust the settings as necessary. o ]
inke

NOTE. Not all of the selections in the —
property page will be available if there is no Graphics and Media s T
external monitor connected to the instrument. Control Panel

| il \ Resolution 1024 x 768
4. Click OK to apply the settings and to i EE

Color Depth 32 Bit

General Settings

close the properties page. it o ST —
‘Color Enhancement
Custom Resolutions Scaling Scale Full Screen

Monitor / TV Settings

Options and Support

NOTE. Although it is not recommended, you can aftach a second monitor after the analyzer is powered on; however, after
connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control panel.
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Installation

Inspecting the Instrument

14

Run the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA6100B Series Real-Time
Signal Analyzers Specifications and Performance Verification Technical Reference manual PDF (Tektronix part number
077-0251-XX) or RSA5100A Series Real-Time Signal Analyzers Specifications and Performance Verification Technical
Reference manual PDF (Tektronix part number 077-0520-XX) located on the Product Documentation CD.

1. Select Tools > Diagnostics. [Took |
3 search...

Alignments...

| Diagnostics l @

Install Upgrades. ..

Options
1908-020
2. On the Diagnostics tab, click All e 4
Modules, All Tests. U Festprogess U
Diagnost :s ‘Powerfon Self Tests | Di Failure Info |
3. Click Single Test. — S e —o—
= odules, ests s STOP
4 C||Ck RUN . Elagr\?;’\mlr:felr:‘atce Board
- SIokRUN D e G s
The instrument will run through the o o 21912012
tests one at a time. A check mark RSO =L Time: 4:01 PM
or X icon will appear to the right -
of each check box as that test is I S
completed. The check icon means B meramt Unth il
the test was passed. The X means B g o
the test was failed. Shal ERERELEE @ ® single Test
5. For tests that require manual M
intervention, follow the on-screen

2838067

instructions to complete the tests.

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (Control Panel > System and Security > Administrative Tools > Event Viewer) to view failure history and nondiagnostic
failures reported by the application.
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Installation

User Maintenance
Caring for the Planar Crown RF Input Connector (RSA6100B Series Only)

The Planar Crown input connector consists of two parts. The first part is the Planar Bulkhead, which is mounted in the
instrument front panel. The second part of the input connector is the Planar Crown, which mates to the Planar Bulkhead. The
Planar Crown can be easily changed should the connector become damaged or a different connector type be required.

No tools are required to remove or install the Planar Crown connector. A reasonable hand tightening of the connector is
sufficient to ensure an excellent connection.

When changing connectors, be careful not to touch inner surfaces of the connector halves.

Use only a 75% isopropyl alcohol solution to clean the Planar Crown connector, if needed. Do not use tap water to clean the
connector. Do not submerge the connector in a cleaning solution. Do not use abrasive compounds to clean the connector.

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

A cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software

Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument

If you return your instrument to Tektronix:

RSA6100B Series & RSA5100A Series Quick Start User Manual 15



Installation

Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

®  When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

B Seal the shipping carton with an industrial stapler or strapping tape.
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

©

Operation

|
I Teq\b f'ﬁuir; @
el- " Yer
| o)
Ref number Item Description Menu equivalent
1 Media DVD£RW drive, removable hard disk drive, or removable
solid-state hard drive.
2 Displays Opens the Displays dialog box to select measurement Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected display. Setup > Settings
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab 2
8 Span (Spectrum) Adjusts the span or frequency range shown in the Spectrum Setup > Settings >
display. ! Freq & Span! 2
9 Amplitude Adjusts the reference level. Setup >
Amplitude 2

RSA6100B Series & RSA5100A Series Quick Start User Manual
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Operation

Ref number Item Description Menu equivalent
10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup > Settings >
BWtab1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

2838-006

Ref number Item Description Menu equivalent
12 Run (Stop) Push to start and stop acquisitions. Run > Run
13 Markers, Peak Moves the active marker to the maximum peak of the trace
in the selected display. If markers are turned off, the MR
(marker reference) marker will appear at the maximum peak.
14 Markers, Select Selects the next marker.
15 Markers, Define Opens the Markers control panel.
17 Control knob Increments/decrements numbers with fine resolution.
18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow moves
the selected marker 10 trace points to the left. The left and
right arrows move the selected marker to the next peak.
(Turning the knob moves the marker one trace point left or
right.)
19 Increment / Increments or decrements numbers with coarse resolution.
decrement keys
20 Markers, Delete Deletes the highest-numbered marker.
21 Markers, Add Adds a marker to the selected trace.
22 Replay Replays the current acquisition record.
23 Single Sets the Run mode to Single Sequence and initiates a single

sequence acquisition cycle.

18
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Bksp
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2838009

Ref number Item Description Menu equivalent
24 Keypad Enters values in controls.
25 Enter Completes the data entry in controls. Same as pressing the

Enter key on the keyboard.

) @) (-
@ =

2838-002

Ref number Item Description Menu equivalent

26 Recall Opens the Recall dialog box. File > Recall

27 Save Saves working file using the same user selections as for the File > Save
previous Save action.

28 Touch Screen Off Turns the touch screen on and off.
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Operation

Ref number Item Description Menu equivalent
29 Help Displays the online help. Help >

User Manual
31 Application Opens the Application preset dialog box. You can change Setup > Preset

the effect of pressing Application using the settings at Setup
>More presets > Preset Options > Preset type/action.

32 DPX For instruments with Option 200, opens swept DPX over Setup > More
the full frequency range of the instrument. For instruments Presets >
without Option 200, opens the DPX display over the Application

maximum real time acquisition bandwidth of the instrument.
You can change the effect of pressing DPX using the
settings at Setup > More presets > Preset Options > Preset

type/action.

33 User Opens the User preset dialog box. You can change the Setup > More
effect of pressing User using the settings at Setup > More Presets > DPX
presets > Preset Options > Preset type/action.

34 Preset Resets the instrument to its factory default settings. You can Setup > More
change the effect of pressing Preset using the settings at Presets > User

Setup > More presets > Preset Options > Preset type/action.
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Front Panel Connectors

Operation
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Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High>2.0V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, 2.5 V to +2.5 V range,
trigger level is user adjustable
3 USB port USB 2.0 connector
USB port USB 2.0 connector
RF Input RF input connector 50 Q

RSA6100B Series & RSA5100A Series Quick Start User Manual 21



Operation

Rear Panel
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Ref number Connector, Description

1 AC Input, main power connector

2 GPIB

3 IF output (Option 55, RSA6100B Series)

4,5 Real Time 1Q Out (Option 05)

6 +28 VDC output, switched

7 Microphone in; Headphone, audio output; and Line In connectors
8 External Trigger 2 Input

9 COM 2, serial port for connecting peripherals

10 VGA external monitor output (resolution not limited to VGA)

" PS2 Keyboard input

12 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)
13 Ref Out, reference frequency output

14 Ref In, reference frequency input

15 LAN, Ethernet network connector

22
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Interface and Display Elements

Operation

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.

POO00066000 & 6 O @

B oo e A W I = ===

m File Viey Fun Reyiay  Mpziers  Setup Tool/ Window  Help - B X
M 5% & T = o A | Frequengy: 150000 GHz Reflev: 0.00 dBm Preset! | o Replay -~ | ) Run -
0 12 1of 10
© 0.00 dBm
© dB/div:
10.0 dB
UA1
-66.04 dB
-100.00 dBm
© Pos: 150000 GHz © Scale: 5.16 MHz
1
Avg Channel | ch  Offset Lower Upper
Power (Main): Al 2.000 MH 66.91 dB 66.04 dB
-3.83 dBm : z o 06
Stopped Acg BW: 20.00 MHz, Acg Length: 99.360 us Real Time Free Run Ref: Int Atten: 15 dB

Ref number ltem

2838010

Description

1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.
Markers Opens or closes the Marker toolbar at the bottom of the window.
3 Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.
Trigger Opens the Trigger control panel so that you can define the trigger settings.
Acquire Opens the Acquire control panel so that you can define the acquisition settings.
Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.
7 Measurement Displays the Measurement Frequency. To change the value, click the text and
Frequency use the front panel knob to dial in a frequency. You can also enter a frequency

with the front panel keypad or use the front panel up and down buttons.
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Ref number Item Description

8 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.

10 Replay Runs a new measurement cycle on the existing acquisition data record using

any new settings.

" Run Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.

You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,

the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

12 Check Mark indicator The check mark indicator ( 4 ) in the upper, left-hand corner of the display

indicates the display for which the acquisition hardware is optimized. When
Best for multiple windows is selected in the Amplitude control panel's RF & IF
Optimization control, none of the measurement displays shows a checkmark,
as there is not a single optimized measurement.

13 Displays the Open dialog box so you can recall a setup file or an acquisition
data file.

14 oo Opens the Save As dialog box so you can save a setup, screen capture,
ID' acquisition data file, or export results or settings.

15

Displays the Main Presets dialog window or recalls Preset (Main), depending

Flreset on current settings.
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Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

@ @

File  Wiew| Run Replay Markers | Setup  Tools  Window  Help 5 x
B o) & T % 5 TR Frequency: 244700GHz  Reflev: 0.00 dBm Preset | B Replay - | 2 Run
¥ Tracel  [¥IShow Sample MNormal \@|

= Position:
-200.00 kHz

()

-3.7000 MHz

il r
[Autoscdle | o position: 99,795 ws © Scale: £21.820 us

Settling Time: 200.50 us Settled Freq: 2.445307 GHe
from Trigger: 196.93 us

2838-024

Table 1: Common icons

Ref number Control icon Description
1 w Drop-down List. Click to select a value from the drop-down list.
2 ] Knob. Click anywhere on the icon or on the text readout to select the control. You

can then change the value with the front panel control knob or arrow keys, or enter a
value from the keypad.

3 6.337us ltalicized numbers. These indicate automatically selected control values. Several
controls in the instrument (for example, RBW and Analysis Length) allow you to
select an Auto mode. In Auto mode, the instrument software automatically sets the
value. You can change the control to Manual mode by changing the value. To return
to Auto mode, clear the value, and then press the Enter key.
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Basic Concepts

Real Time Analyzers

Tektronix real-time analyzers, such as the RSA6100B Series and RSA5100A Series Real-Time Signal Analyzers, have an
optional frequency mask trigger. The frequency mask trigger allows you to set up a spectral mask to capture a signal when a
spectral anomaly occurs. This allows the real-time signal analyzer to check 100% of the input signal before acquiring, and
then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events. Option 200 includes the ability to measure and trigger on signal density values in the
DPX display.

The RSA6100B Series and RSA5100A Series Real-Time Signal Analyzers allow you to view the captured signals in a wide
variety of time-correlated displays. This is useful for device troubleshooting and signal characterization applications. All of
the measurements, other than the DPX display, are based on the same underlying set of time domain sample data.

Measurement Displays

The analyzer window can show one or any combination of general purpose and application-specific displays.

This example shows a DPX Spectrum Split e =
d|sp|ay_ A DPXogram d|sp|ay appears Fle View Run Replay Mrkers Setup Tools Window Help 5 x
on the top and a DPX Spectrum display O e N e B

Replay: AcqDats =~ 14 4 @ b Bl B D Select All Select.. 1 10/24/2011 23:17:4.59

appears on the bottom.

Spectrumsfline: 1

o Time/div:
2.50s
3-D

o Pos:
0.0 div

“ DPXogram |¥|Show +Peak Clear
< 0.00 dBm
o dBfdiv:

10.0 dB
o RBW:
500 ktiz

Split -

-100.00 dBm
Autoscale o CF: 1.5000 GHz @ Span: 85.0 MHz

Stopped Not aligned Real Time Free Run Ref: Int Atten: 15 dB
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This example shows the window with two
displays, a Spectrum display and a DPX
spectrum display.

When you have more than one display
open, the display with the check mark icon
has control over the acquisition hardware.
To give a display priority over any others,
click its title bar.

This example shows four displays in the
window.

Tek RSA61008

Operation

(=™
File View Run Replsy Markers Setwp Tools Window Help
B ® & T % % I% | Frequency: 10000000 GHz  Reflewi 0,00 dBm Preset. Repla: ) Stop
B DPx Spectrum = [ @ [ 5= || ¥ Spectrum
v stmep  [¥show on [ clear| v Trace1l [/show +peak Normal
© 0.00 dBm © 0.00 dBm
o dB/div: o dB/div:
10.0 dB 10.0 dB
» RBW: & RBW:
1.00 ki 1.00 ktiz
vaw:
fir
/|
}‘i
[P
\ LA
i I
\ ‘I ‘“‘“‘ | H‘N‘U I
-100.00 dBm - LI 100.00 dBm || 1] |
[ Autoscale | © CF: 1.0000000 GHz © Span: 100.0 kHz [ Autoscale | © cF: 1.0000000 GHz © Span: 100.0 kHz

Transfer Acq BW: 156.25 kHz, Acg Length: 2.591 ms
— T T T

Real Tme  Free Run

Ref: Int_Atten: 25 dB

Tek RSA61008

(=™
File View Run Replsy Markers Setwp Tools Window Help
|S] @ € T & %[5 Frequency: 10000000 GHz  Reflevi 0.00 dBm s | @ Repla 2 Stop
Amplitude vs Time o [@][= DPX Spectrum
¥ Tracel [¥show +peakNormal [ clear | v Btmap  [Ishow on
© -3.95 dBm © 0.00 dBm
o dB/div: o dB/div:
10.0 dB 10.0 dB
o Span: oLE
1000 kiz LIl
-103.95 dBm
[ Autoscale | i
RMS: -10.94dBm © Position: -1.116 ms o Scale: 2.232 ms -100.00 dBm -
Ma: 5.820Em @ 409.6us Mn: 45.180Bm @ 102.4us | Autoscale | = cF: 1.0000000 GHz © Span: 100.0 kiz
Spectrogram o (@ ][ = || spectrum o [®@ =
Spectrums/lin +Pezk [clear| ~ Tacel [Vshow +peak Normal [ clear |
o Time/div: e
o =~ 0.00 dB
111 ms m
- RBW: o dB/div:
1.00 krr 106
& RBW:
vBW:
1.00 ktiz
vaw:
3D
o Pos:
@04 = -100.00 dBm
[ Autoscale | © CF: 1.0000000 GHz © Span: 100.0 kHz [Autoscale | = © Span: 100.0 kHz

Transfer Acq BW: 156.25 kHz, Acg Length: 2.606 ms
— T T T

Real Tme  Free Run

Ref: Int_Atten: 25 dB

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays

The RSA6100B Series and RSA5100A Series analyzers use multiple displays to keep operations simple, and yet provide
advanced functionality when needed. Some of the display categories include:

®m  General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

®  Analog Modulation. These displays show graphs and measurements for Analog Modulation, Frequency Modulation,
and Phase Modulation.

= General Purpose Digital Modulation displays. Available with Option 21, General Purpose Modulation Analysis.
These displays show the results of demodulating signals and analyzing them in multiple domains. Examples of these
displays include: Constellation, EVM vs Time, Eye, Symbol Table, and Trellis diagrams.

= RF Measurements displays. These displays show the results of automated measurements on RF signals. Examples of
these displays include: ACPR, MCPR, Phase Noise, and CCDF.

= OFDM Analysis. These displays provide OFDM analysis for WLAN 802.11a/j/g and WiMax 802.16-2004 signals.

m Pulsed RF displays. Available with Option 20, Advanced Signal Analysis. These displays show the results of advanced
analysis for pulsed RF signals. Examples of these displays include: Pulse Statistics, Pulse Table, and Pulse Trace.

m Audio Analysis. These displays measure basic time- and frequency-domain parameters of analog audio signals
modulated on a carrier (AM, FM and PM modulation) or unmodulated (non-carrier) audio signals (Direct).
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Selecting Displays

The analyzer provides an easy way to select displays.

1. Click the Displays icon to open
the Select Displays dialog box.

Mk RSA5100A - [Channel Power
File

View Run Replay Markers

Setup  Tools Window Help

There are two ways to select displays: choose any combination of displays or use an Application Preset.

Choose any Combination of Displays. Select displays one by one as needed.

1. Click the desired application folder
in the Select Displays dialog box.
The available displays for each

folder are listed in the Available
Displays pane.

2. Click one of the display icons.

3. Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.
Repeat the procedure to add other
displays.

4. Click OK to close the dialog box.
The selected displays will open.

5 & & T % £ I8 | Frequency: 1.50000 GHz RefLev: 0.00 dBm Praset | by Replay = | ) Run
2838011
B Sec il oo e

Choose any combination below, or use an Appli@reset. l Application Presets, .. I

Foldars: Ayailable displaws:
AMPL
Analog Madulation g
GP Digital Modulati
RF Mgszrenzeﬁﬁs on Armplitude vs Frequency  Phase ws
OFDM Analysis Time ys Time Tirme
Pulsed RF
Audio Analysis M
RF I&Q) vs  Spectrogram Time
Time Crerview
Selected displays:
]
Spectrum
4 Rernove
OK l l Cancel I
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Use an Application Preset. Select displays from the presets for your application.

1. Click Application Presets in the Select
Displays dialog box.

2. Select one of the presets.

u Select Displays EI@

Choose any combination below, or use an Application Preset, Application Presets,., @

Awalable displays:

AMPL -

RF Measurernerits Amplitude vs DR Frequency  Phase vs
OFDM Analysis Time ws Time Tirme

Pulsed RF
oA

Audio Analysis
RF I&Q vs  Spectrogram Tirme
Time Cverview

GP Digital Modulation

NOTE. Some presets appear only if the
associated instrument option is installed.

3. Click OK to close the dialog box. The

preset displays will open. (See Table 2.)

Table 2: Application presets

Presets

2838062

Application P X

Spur Search Multi Zone 9k-1GHz ‘ @

Modulation Analysis
Pulse Analysis

Spectrum Analysis
Time-Frequency Analysis

To go directly to a preset in the future, use Tools->Options->Presets-=Preset action

LOK_] Cancel

283012

Displays

Modulation Analysis (Option 21 only)

Constellation, DPX Spectrum, Signal Quality, Symbol Table

Pulse Analysis (Option 20 only)

DPX Spectrum, Pulse Table, Pulse Trace, Time Overview

Spectrum Analysis

Spectrum

Spur Search Multi Zone 9k-1GHz

Spurious

Time-Frequency Analysis

Frequency vs Time, Spectrogram, Spectrum, Time Overview
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Quick Tips
m  Push the Displays button on the front panel to open the Select Displays dialog box.
®  To add a display, double-click the icon.
= To remove displays, do one of the following:
= Select a display icon in the Selected Displays list, and then click Remove.
= Double-click a display icon in the Selected Displays list.
= Click the Close button in the upper right hand corner of the selected display.

= You can mix displays from multiple application folders.

Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 3: Common information messages

Message Explanation and recommended action

Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

m A display other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

B The data is from a recalled file.

There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.

Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.
RBW increased to 100 kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.
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Changing Measurement Settings

The displays have settings that control how signals are acquired and processed. The settings that you can change depend

on the selected display.

To access the settings (in this case, for the Spectrum display):

1. Click Settings to open the Settings Fe way [m G

Markers  Setup  Tools ‘Window  Help -
Contr0| pane' B & & T & & [A | Frequency: 190000 GHz Reflev: 0,00 dBm Praset Replay =) Stop -
@ 2838025
2. Adjust the controls as needed for your spectum Fren & 5pan | Bw | Traces | Scdle | Profs
H ettings
;I%r:]al&oé Ft;sr,]t.tal;otroe;:tn;g:,ugzsyt:‘i ; Center:  1.0000 GHz Span:  85.0 MHz wacspan |
Start: 18575 GHz
span. Most of the control panels have
tabs that provide easy access to other S e
related controls. | pestore | SRISIS: {50000 1042 9 o
3. You can change the appearance of the Rl \my B i B SO e e e & x
display screen in the Prefs tab. Not all ] &g T ¥ »:ir'«; Frequency: 100000 GHz  Reflewi 0.00 dBm Breset | O Feplay Ostop -
of the following controls apply to every o e 2T [gex ]
display. Some displays have additional o i Marker readout
controls not described here. o FW:
50.0 kiHz
VBW!
®  To turn on or off the graticule, select
the Show graticule check box. 100,00 dm
Autoscale o CF: 1,90000 GHz © Span: 5.00 MHz
= To turn on or off the marker readout, et e Span [ B0 Trses [ s | 7156 ¢ @ &
select the Show Marker readout in
ra h Check box Show: | Center, Span v] Trace points: [am v]
g p : V| Show graticule [¥] Show Marker readout in graph (selected marker)
s Marker Moise mode (Requires dBm Ampl units and
= To turn on or off the trace legend, s s e iverag tare dotect) ’
Defaults
select the Show trace legend check i —— —
Markers [ Define | « MR Frequency ~|180131875 GHe [ Tocenter | [peak | [« [#] [#] [#] [ Tabe |[x |
bOX 2838053
Quick Tip

= |f you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control

panel for that display.
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument
settings, push the Preset button on the
front panel or select Preset from the
Setup menu.

Quick Tip

Operation

| o

<Displays> (Settlngs CRun/Sto@

Freq Acquire ( single )

Span
Ampl

@

(=) (=)

i

Trigger

Arm
Ready
Trigd

2838022

= Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.
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Connecting a Signal

The analyzer has a single RF signal input located on the front panel. Make sure that you observe the input signal

requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any
electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables attached to the instrument with

the other ends of the cables open.

Required Signal Levels

The following table shows the input signal levels over which the analyzer can be used for measurements. The accuracy is
guaranteed at a signal amplitude and frequency (normalization point). Measurements can be made on signals within the
entire range of allowable inputs, but the accuracy of the measurement is affected by the frequency and amplitude of the
signal to be measured (see the RSA6100B Series or RSA5100A Series data sheet for more information).

RF signal input range (CW or peak envelope power)

Modulation measurement requirement

Spectral display requirement

-50 dBm to +30 dBm

DANL to +30 dBm

Input signal requirements

Characteristic

Description

Input impedance

50 Q

Input frequency range
RSA6106B
RSA6114B
RSA6120B
RSA5103A
RSA5106A
RSA5103A/RSA5106A

9 kHz t0 6.2 GHz

9 kHz to 14 GHz

9 kHz to 20 GHz

9 kHz to 3 GHz (RF Band)
9 kHz to 6.2 GHz (RF Band)
1 Hz to 32 MHz (LF Band)

Maximum measurable continuous input power

1 W (+30 dBm)

Maximum voltage rating

RSA6100B: +40 V DC, AC coupled
RSA5100A - £5 V DC, AC coupled

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). For the

A RSA6100B Series, the maximum voltage rating is +40 V DC. The maximum pulse specifications are 75 W peak, 10 us pulse
width, 0.001 duty cycle, and 230 dB attenuation. For the RSA5100A Series, the maximum voltage rating is £5 V DC. The
maximum pulse specifications are 50 W peak, <10 us pulse width, 0.001 duty cycle and 230 dB attenuation.
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To connect an RF signal:

Operation

m  Connect the signal to the RF INPUT

connector on the front panel.

NOTE. On RSA6100B Series instruments,
you can change the RF input connector type
by using a different Planar Crown connector.

Quick Tip

u
output to the RF Input connector.

Starting and Stopping Acquisitions

1. Click the Run button to start an

acquisition.

To select the Run mode, click the
drop-list icon to the right of the Run

If the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator

button.

[E=E(E=E ==
Window  Help g X
RefLew: 0,00 dBm Frasst | @ Replay  ~ | D) Run -
[E=N{E= ==
& x

Select Single or Continuous to
set the Run mode as necessary.

Preset

If the analyzer is in Continuous
Run mode, the Replay button is
dimmed while acquisitions are
active. If there are no acquisitions

Preset

@ Replay

= Gingle
) Continuous

Replay

active, the Replay button is blue.
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2. Click the Stop button again to stop (oo e

an acquisition. If an analysis is in ;
process, it will finish its sequence Wincong | wielp g x
and then stop. Reflew: 0.00 dBrn Praset Replay =) Stap -

Clear

Quick Tip

= Push the front panel Run button to start and stop acquisitions.

Run Control

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to

the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.
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Markers

Operation

Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure
the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.

1.

Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

Select Add Marker from the
drop-down list on the Marker
Toolbar.

The first marker is designated
the marker reference (MR).

Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

Read the frequency and power
level from the marker readout on
the display.

File  “iew  Run  Replay  Markers  Setup  Tools  Window  Help

B 5 &

T %

Frequency: 190000 GHz ReflLew 0,00

@

Define Markers Marker Properties | Define Peaks‘

283026

|
Reference Delta Markers o
| Add | Marker:
Attach to:
| Delete | (in selected
display) —_—
Readouts:  |Delta -
[aor | Add Marker ‘ |
Delete Marker }
Markers All markers off | To Center | | Peak | Table || x|
2836007
P Tek RSAS100A - [Spaetcg] = |2 .
File  View lay | Markers Setup Tools Window Help & x
= @\~ / ¥ IR | Frequency: 1.90000 GHz Reflev: 0.00 dBm Preset Replay Dstep -
“ Tragz1  [VIShow +Peak Normal |C\ear ‘
< 0,00 dBm
o dBfdiv:
10.0 cb
- REW:
50.0 k7

WBW:

-100.00 dBm

| Autoscale | © R 1.50000 GHz

Markers | Define ‘ v MR

Frequency ~| 1900875 GHz

s=pan: 5.00 MHz

To Center ‘ Peak z\ EJ ‘z‘ E‘ I Table HI|
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Markers Display

m Rectangular markers show absolute values in the readout. The readout of the selected marker appears in the upper left
corner of the display and in the Marker toolbar.

= Diamond markers show delta values (relative to the reference marker). The delta readout of the selected marker appears
in the upper right corner of the display and in the Marker toolbar.

= When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

B When you attach the marker to the bitmap trace in the DPX spectrum display, the marker readout indicates the hit count
for pixels (maximum 65,536) along with frequency and power (see the following figure). You can position the marker
at any point in the graph.

® In RSA6100B series and RSA5100A series instrument with Option 200, markers attached to the DPX bitmap display
the signal density in percent at the selected pixel, rather then the hit count.

Tek RSA51004, - [DPX Spectrurm]
File  View  Run  Replay  Markers  Setup  Tools  Window  Help

= éﬁ T & & [% | Frequency: 19000 GHz Reflew: 0.00 dBm

Bitman _ [V|show On

© 0,00 dBm

o dBjdiv:
10,0 de

= RBW:
800 faHiz

2838054

Quick Tips

= |f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

m  Click Table in the Marker toolbar to open a tabular display showing the marker information.
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 4.) Some of these controls are similar to those
on the front panel.

Table 4: Marker toolbar

Description

Opens the Define Markers control panel. Use the control panel to add and remove markers and

Define
to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the selected marker. This

To Center
button is only present when the selected display has frequency on the horizontal axis.

Moves the marker to the maximum peak level on the trace. The maximum peak can be either the
highest or the lowest point in displays with both positive and negative values on their vertical axis
(such as Frequency Error or Phase).

Peak

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-lower-amplitude density peak at the same frequency.

Moves the selected marker to the next higher peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-higher-amplitude density peak at the same frequency.

Table Opens or closes the marker table in the display.

I B E|3|E III_

Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.
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Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers wakers [Defe] « MR [Freauengy 190010835 Gr [« ] [

control panel. P

Use the control panel to: Define Markers | Marker Properties | Difne Peaks]
Reference Delta Markers
= Add or delete markers. e ko .
Aftach to: Bitmnal =
= Turn markers off. st
Readouts:

B Assign markers to specific traces.

Markers v MR [Fremuency +|1.00010625 GHz (] [*] [+

m  Set the marker readouts to absolute or
delta.

m  Define the threshold and excursion
values.

Quick Tip

= You can add or delete markers from the drop-down list next to Define in the Marker toolbar.

Touchscreen Actions

40

You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Some selections in the Touchscreen Actions IE -
menu are selectable only when a marker is
. [+*| Span Zoom
defined.
+»  CFPan
@\ Zoom
1'1:",? Pan
Reset scale

Marker to peak
MNext peak 3

Add marker
Delete marker

All markers off

Trigger On This

Touchscreen Actions menu

RSA6100B Series & RSA5100A Series Quick Start User Manual




Table 5: Touchscreen actions menu

Icon

Menu item

Operation

Description

Select

Selects markers and adjusts their position.

Span Zoom

Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.

Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan

Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings to their default
values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Positions the DPX Density measurement box at the click point, measures the
current signal density, sets up the DPX Density Trigger function based on the
measurement result, and starts acquisitions.
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1.

42

Push the Print button on the front panel
or select Print from the File menu.

=]

Recall... Ctrl+O
Save Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

Acquisition data info

Measurement data info

Print... Ctrl+P @

Print Preview

Prezet (Main)
Maore presets »

Exit

2838013
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2. Fill out the details in the Print dialog box, Print ==
and then click OK. Printer
The Print dialog box is the standard Name. [ adobe PDF v| [ Properies. |
Microsoft Windows Print dialog box. The Status:  Ready
. Type: Adobe PDF Coreerter
pr!nter controls are dependent on your o, Dommentstodt
pl‘lnter Comment: [T Prit to file
Frint range Copies
@ Al Nuriber of copies: 1 5
Pages B0
it
) Selection 12'3 12'3 o
Ink Saver Mode
You can print screen images with a white background.
1. Select Options from the Tools menu. Tools | Window  Help
¥} Search.
Alienments...
Diaenostice
Ihstall Uperades..
Optiohs :I @

1900-145

2. Select the Colors tab in the control panel. Fle View Run Replyy Motkers Sep Tools Window Help _Ex
® @ T % I Frequency: 19000 GHz Reflev: 0.00 dBm B | © Replay Dstop -
3. Set the Color Scheme to Blizzard. v Trael  [Show +Peak Noml
© 0,00 dBm
The background color changes from o g
black to white in the graphs. o REW,
500 kHz
[E] wew:

R

-100.00 dBm
© CF 1,9000 GHz © Span: 85.0 MHz
Options | Presets | analysis Time | Save and Export | GPIB | Security | Pref @

[7] Markers snap to peaks when dragged

283805
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Saving Data

You can save different types of data for future use.

1. Select Save As. from the File menu to Fie |

open the Save As dialog box. & rel... crl+a
& save ctrl+s
| Save As... ! @
Data properties... [S
&h Print... Ctrl+P
Print Preview
3 Preset
Application Presets. ..
Exit
1909039
2. Navigate to the folder where you want [ e =
to save the SetUpS, or use the default EHE0 =]« Defult(C) » RSASL0AFiks @ Sermple Data Records » [ | [ Scarch Sampic Cata Records 9|
location. Organize v New folder = ©
R4 “| Name '@ Date modified Type Size  *
] B WifisA0AM20M tig HATAINA 1504, TIQ File 14
3. Enter afile name. 4 Libraries |8 wiFiBPSK20M.Eq L7000 338 P TIG File 18
3 Documents B WifiQPSKSM tig 11/17/2010 5:10 PR TIQ File 14
4. Select the type of file to save. (See o husic 5 m wifiQPSKIOMtig LT/ 17 PR TG File 140
& Pictures B wiFiQPSK20M.tig LUAI/200 330 P TIC File 18
Table 6.) B Videos 9] Wil L6 QARSI tig 11/18/2010 10:19 .., TIQ File 520

(M) Wina6 40020 T/2010 6:20 P s _
. 1% Computer ] iMaxBP KM i /2010 10:37 .. 521
5. Click Save. R \ :
& Defautt (C) [B] WM QPSK2OM 1742010 6:35 PR 52
I WinT_external (B ~ i

File name: -

Save as type: | Acq data with setup (TIQ) (*.tiq) -

“ ' Hide Folders @ Cancel
Table 6: File types for save
File types Description
Setup files Saves all of the setup information for all settings displays, except those settings that

are specified under the Tools menu (Alignments and Options) or in the Config In/Out
control panel.

Results Export files Saves the trace and numeric data for the selected display. The trace and numeric data
are saved in CSV format as text files.

Picture (PNG/JPG/BMP) Saves a graphical representation of the screen in the specified format. This option is
useful for including the graphic in reports or other applications. Marker readouts and
other information are included.

Selected Trace Saves a trace for later recall back into the display from which it was saved.
Data (acquisition data and Saves data for reanalysis by the RSA6100B Series or RSA5100A Series analyzer or as
acquisition data export) CSV (comma-separated value) or MAT (Matlab) format to use with external software.
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Operation

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

m  Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.

Recalling Data

You can recall and reanalyze acquisition data and setup files previously saved by the RSA6100B Series or RSA5100A

Series analyzer.

1. Push the Recall button on the front panel

. File
or select Recall from the File menu. |
| Recall.. Cirl+0 &
B Ssave Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

Acquisition data info

Measurement data info

Print... Ctrl+P

Print Preview

Preset (Main)

Mare presets »

Exit
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2. In the Open dialog box, browse to the m
location of the file.
OF'E_” @
3. |f y0U dO nOt see the flle Select the type @U° « Default (C) b RSAS1004 Files » Sample Data Records » -|¢,|| Szorch Sompie Data Records P |
of file from the drop-down list. ST ST § =- 0 e
RSA i Marme R ?itf Itn,o,‘iiﬂff‘, Ty‘pe . Size - i
H 1 1 . (B IFIBP S 0h. 1141772010 3:38 PM - TIQ File 144 KB
4. Double click the file name to load the file. 3 B ot o o e
J- auzuments E B WifiQPSK10M.tg 11/17/2010 4:17 PM - TIQ File 144 KB
é P\::\.‘n('es W WIFIQPSK20M tig 1141772010 3:30 PML - TIQ File 144 KB
E Videos W Wik BQAMSM tig 11872010 10:19 .. TIQ File 520 KB
Wi ax640AM20M tiq 11/17/2010 6:20 PM - TIQ File 520 KB

m

B Comou B Wit axBP 3K tig 11/16/2000 1037 ., TIQFile 520 KB
armputer

r= P W Witdax(QPSK20M g 11/17/2010 6:35 PM - TIQ File 520 KB -

&, Default (C) . -

34 items

File name: + | Acq data with setup (TIO) (htic

2838061

Quick Tip

If you recall a trace that has an x-axis range that does not fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.
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Advanced Techniques

This section contains advanced operating techniques. For examples of practical applications, see the RSA6100B Series
Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers Application Examples Manual.

Setting Up Triggering

The RSA6100B Series and RSA5100A Series Real-Time Signal Analyzers offer real-time frequency domain triggering
(option 52) and frequency edge triggering in addition to power-level triggers, line trigger, runt trigger, and external triggers. It
uses a trigger event as a reference point in time for the seamless acquisition of the signal. This allows the analyzer to store
both pretrigger and posttrigger information.

The analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:

®  RF Input

® Trig In

B Trig2ln

= Gated

® Line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input

as the trigger source, you can chose from two trigger types:

DPX Density Triggering. This trigger type enables the instrument to capture any signal you can see in the DPX display,
including difficult to see signals hiding beneath other signals that have a higher amplitude or a greater repetition rate. Using
the Trigger On This™ feature, you can draw a box around the area of interest in the graph, set a Density threshold, and
the instrument will trigger when the measured Density exceeds your threshold.

Time Qualified Triggering. Time Qualified triggers allow you to trigger the instrument based on when signal transitions
occur in time. You can apply time qualification to the basic trigger types. For example, if you select the Power type and
configure it to trigger on a rising edge, Time Qualification allows you to screen rising-edge events based on how long the
signal stays high after it exceeds the trigger threshold. You may wish to trigger only on pulses that last longer than a
specified time or shorter than a specified time. You can set Time Qualified to accept only pulse widths between two specified
values, or outside of these two values.

You can also time qualify Frequency Edge, Frequency Mask, DPX Density, and Runt trigger events. For each trigger type,
the instrument finds all events that meet the basic trigger criteria, then further tests them against your time qualification
parameters.

Frequency Edge Triggering. Frequency Edge triggering triggers the instrument on time-domain signal characteristics.
The incoming data is compared to a user-selected level in Hertz. Frequency edge trigger is similar to Power triggering,
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except you also need to set a power threshold to avoid triggering on the apparent frequency fluctuations that occur at low
amplitude. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Runt Triggering. Runt triggering defines a trigger event based on a pulse amplitude that crosses one threshold but fails
to cross a second threshold before recrossing the first.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

®  Position and Delay parameters that define where a trigger occurs within the acquired data record and whether to
delay the trigger for a set amount of time.

= Whether a single event can trigger an entire sweep, or each segment of the sweep requires a new trigger event in
swept acquisition mode.
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Accessing Trigger Parameters

1. Click Tl’lg to open the Trigger control e e e i indow | Help .8 x
paneL & & T = & 1 Frequencys 13000 GHz RefLew 0,00 dBr Breset] | O Replay Dstop -
2838082

2. As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters.

Trigger Event | & Time Qualified | Advanced | Actions|
3. Use the Event tab to set parameters that Source: Siope
define trigger events. The parameters @ e tn A 1oz (EEEEER
vary depending on the trigger Source - Tiagered Tyee: _ ] Trne-domain BW:
and Type selections. Foree Tioger o |4/ Aot B500

2838063

4. Use the Time Qualified tab to set
parameters that qualify trigger events
based on their time duration.

O

Trigger

t | & Time Qualified |Advanced |Acti0ns|

- @ MNone
@) Free Run )

[ — Time 1 10.000 us
. - H . L
@ Triggered ) Shorter ) Inside T
O Trigg :
© Langer 0 Qutsice T
Force Trigger - .

2838-064

5. Use the Advanced tab to set parameters Trigger Event | ® Tive Qualfied | Advaced | Actions
for trigger position and holdoff settings.

—

_ [7] Holdoff:  1s
LD R Position: 50 % Auto . —
) Triggered F
petay: 02
[] Trigger each segment of Swept acquisitions

Force Trigger

requires trigger signals across entire Span

6. Use the Actions tab to set parameters for  [event | @ Time qualfied | dvanced | Actions |
the Save on trigger function. The Save
on trlgggr.f.unctlon a!lows you to save Fswescadhtscn Trgger: Q. Hax éoé;lrﬁFIEsn :
an acquisition data file and/or a screen (1 complete acousition,
capture when a trigger event occurs. el LN =)

100

|| Save picture on Trigger: PHG -
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Quick Tip
m  Other ways to access the Trigger control panel;
= Push the Trigger button on the front panel.

= Select Trigger. from the Setup menu.

Setting Up a DPX Density Trigger

The DPX Density trigger captures transients partially obscured by other higher-amplitude or more frequent signals. If you
can see it in the DPX bitmap, you can trigger on it. The DPX Density area measurement is used to select the region of
interest in the display and to measure its current density. You set a density threshold, and the instrument triggers when the
density measurement exceeds your threshold.

The quickest way to set up a DPX Density trigger is to use a mouse and right-click on a signal of interest in the DPX
graph, or press on the screen and hold with your finger for one second. A menu will pop up. Select Trigger On This.
This action performs several tasks:

B Places the density measurement box at the click point

®  Sets the measurement box to its default size

B Measures the average density in the box

B Sets the Trigger mode to Triggered

B Selects the DPX Density "Higher" trigger type

®  Adjusts the trigger threshold to a density value slightly below the current measured value
B Starts the acquisition process

To optimize DPX Density trigger settings for your particular signals, open the Trigger control panel. Use the controls for
changing the polarity of the trigger's threshold comparison (Higher versus Lower), the Threshold value, and the size and
location of the measurement box. Use the Frequency and Amplitude settings to locate the center of the box, and set the +/-
values to adjust the width and height of the measurement box.

For events that are partially masked by stronger signals, you will often need to adjust the density Threshold based on
density measurements of the event of interest and of the obscuring signal. For example, if the density of the background
color representing only the stronger signal is 7% and the density measurement including both signals is 9%, you would
set the Threshold to 8%.
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[ Tek RSA61008 - [DPX Spectrum] =) [ S|
File View Run Replay Markers Setup Tools Window Help - x
i W) G} 3 requency: 2. iz ev: - m Preset Replay top v
& PH T TN R 205110 GH. RefLev: -20.00 dB Repl DS
v Btmap  [¥Show on

© -20.00 dBm
o d8/div:
10.0 d8
o RBW:
400 KHiz

Acq BW: 40.00 MHz, Acq Length: 8.660 us Real Tme  Free Run Ref: Int_Atten: 10 dB
i —

If your expected signal is a continuous tone and you want to capture events when it hops to a different frequency or drops
to a lower amplitude, move the Density measurement box to surround the peak of the signal, select Lower in the Density
control, and set Threshold to 100%. The instrument will trigger when the signal is absent from the measurement box.

Hint. The density measurement is the average of the densities for each column of pixels in the box. If your measurement
box is wider than the peak of a CW signal, the density reading will be less than 100%. To get a 100% reading, you can
broaden the peak by increasing RBW or narrow the box until there are no colored pixels either above or below the box. The
signal should enter the left side of the box and exit the right side. It should not cross the bottom edge of the box.

Creating a Frequency Mask

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

You can create a Frequency Mask by using either the manual or Auto Draw method. The following procedure explains the
manual method. For a procedure on how to use the Auto Draw method, see the topic Mask Editor (Frequency Mask
Trigger) in the online help.

1. Click Tr|g to open the Trigger control File View FRun  fepley  Markers Setwup  Tools Window Help & x

pane| [l & & T = & 1 Frequencys 13000 GHz RefLew 0,00 dBr Breset] | O Replay 2 Stop

@

2838062
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@ Free Run SDUL —J T T=F T=FaT Mask Editar
H . RF Input ¥
Click Mask Editor to open the Mask FoeRT  ORTF [ Load from fl..|

Triggered

Editor. Type:
. Freauency Mask = T ﬂ ke RBW: S00kE [ Auto
Force Trigger

The Mask Editor opens with the traces of
the Spectrum display in the graph. s

6. Click New in the tool bar. This removes 6
the existing mask and then creates a A

default 6-point mask. File

New ‘ Open Save ‘

Click in Add points — ¥ Margin: 5.000 MHz
araph MNext X Undo
to: @ Edit Paints

Y Margin: 10,000 dB

2. Select the Event tab in the control panel. @ @ @ @
3. Set the Source to RF Input.
Trigger Event | & Tinle Qualifie, | Advanced | Actions
4. Setthe Type to Frequency Mask. . LEEy
5.

=1 Be| =5
Reference;
Save ... ‘ ‘ Done ‘ Spectrum Trace 1 A

(to be in list, a trace must be showing in a display)

0,00 dBm
Auto draw
'|

J (Offget Freq Amplitude i

\‘M ‘r‘m ‘| At |]|| J A \w -17.000 MHz -30.00 dem

} -9.500 MHz -10.00 dém
8,500 MHz -10.00 d&m £

SO EE 17.000 MHz -30.00 dBm
CF! 1,900 GHz Span: 55.00 MHz 42479 Mhe +30.00 d8m -

2838037
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7. Click any point in the mask to select it. S =
The frequency and amplitude of the il
selected point are highlighted in the [ new [[ oon [ sue [[smers [ o | foEe Lsgji'“mu'szhluw'ng mmu;yl)
granh. | | Cgh;:akup © add points — . ¥ Margin: 5.000 MHz

8. Edit the point by doing one of the ti @ Edic Paints ‘ ¥ Margin: 10,000 ¢
following: 0.00 cBm e E \E

® Drag and drop the point with the

mouse. |
[ Oftyet Freq Amplitude i
B Enter the frequency and amplitude in Tn"rUu“T'l i ,|' i \ w‘ i ”M‘h ‘”'I ‘J"“w‘ i
the table. 8.500 MHz -10.00 dBm
) ) ) S CE 17.000 MHz -30.00 dBm
B Adjust amplitude with the Up/dOWﬂ & AETIE s EEDIT 42.479 MHz -30.00 dBm =

arrow keys and frequency with the
left/right arrow keys.

2838038

Quick Tips

m  Click Auto draw to generate a mask automatically adjusted to the Reference.
B Right click on the display screen to add a new point.

= Click Add Points and then click on the graph to add a new point in the graph.
= Click Next to select the next point in the graph.

m  Click the X (delete button) to delete the selected mask point.

m  Click Save to save the mask file and continue working with the mask editor.

= Click Open to load and edit a previously saved mask file.

Defining Trigger Conditions

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.
The choices are described in the

. . Trigger Event | & Time Qualified | Adh o | Acti
following table. (See Table 7.) The icons kel al ‘
at the bottom of the control panel identify ® Free fun mivl 5T T eTeT [ vascEater |
what is considered true or false. S— — OF  @BT  @pDF
B Type:
2. Gl Triggered )| ) P P o e
The instrument will trigger when the @ )

trigger conditions are met.
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Table 7: Trigger violations

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no violation)
after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after being

outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask, cross
outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask (no
violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when you analyze recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a

Spectrum display and a DPX Spectrum
display. The highlighted title bar on the
Spectrum display indicates that it is the
selected display.

The check mark indicator in the upper
left corner of the display indicates that
acquisition hardware is optimized for the
Spectrum display.

Tek RSAG1008

File View Run Repla

Markers  Setup Tools Window  Help

B & 8 T % % 1% | Frequency: 10000000 GHz  Reflew: 0.00 dBm Freset Repla 2 Stop

DPX Spectrum

v Btmap [@show on [(ctear ] v Tacel [@show el Clear

2 0,00 dBm
» dB/div:
100 dB

-100.00 dBm

| Autoscale | ©

= [ | = || spectrum =

© 0,00 dBm
o dB/div:
10.0dB

" \"\ﬂl‘.“"‘l"\ \"‘\ b

. i T
J i MM
il A
-100.00 dem || ‘ l'“ ‘

"
il | [l 1 ” \‘
I
il
| Autoscale | © CF: 1.0000000 GHz © Span: 100.0 kHz

Transfer

Ref: Int _Atten: 25 dB

—

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The RSA6100B Series Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers let you open any
combination of measurements. You can select the displays that you are interested in and the instrument will automatically set
up the appropriate analysis and acquisition parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1.

Push the Preset button on the front
panel to set the instrument to the default
settings.

Tune the instrument to the frequency of
your signal and then set the span.

Click the Displays icon to open the Select
Displays dialog box.

Select the General Signal Viewing
folder.

Select the Amplitude vs Time icon.

Click Add to add the icon to the Selected
Displays list.

NOTE. Add the Spectrum display if it is not
already in the Selected Displays list.

1.

Click OK to accept the changes and
close the dialog box.

—J
= | L
s
Presets
Cor)

2834-066

File View Run Replay Markers Setup Tools Window Help -8 x

B S & @[T % 15| Frequency: 19000 6Hz Reflev: 0.00 dBm el | @ Replay - |2 Run

2834002

Select Displays [E=H 5

Choose a@ﬂat\un below, @Apphcatmn Praset, Application Presets...

Folders: Availabl) displays:

General Signal Viewing =

#nalog Modulation ) o

GP Digital Modulation -

RF Megasurements DR Frequency Phase vs

OFDM Analysis vs Time Time

Pulsed RF m
Audio Analysis . M

RFIZQvs Spectrogram  Time
Time Cverview

Selected displays:

Spectrum

Remove

@ =) [ow ]

283805
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8.

10.

Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,
all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

»

Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn't contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.

[ Tek RSAG100E, [E=Rl ™
File View Run Replay Markers Setup Tools Window Help
= © & T ¥ % I\ | Frequency: 10000 GHz RefLev: 0,00 dBm Fea) | O Repla O stop
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= T T :
@ -
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Repla
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11. Decrease the span to 25 MHz in the I s o s
Spectrum display. Now the acquisitions BIIS @ T % 5 I Feavnos 1000GHE  fefer 2003 6 |0 ki | D
are real time again' :{mpmuzlﬂﬂ‘vmi Trace 1 V|Show +Peak Normal - Bﬁ spenmm v Trace 1 V|show +Peak Normal - 5

© -3.95 dBm « 0.00 dBm

12. Check the status bar readout to verify “nia i
that the acquisition is real-time. o S
Both of the displays can run now.

Ayl H‘ \‘IM' ‘wh.\“ I ) "\ ”
[ fa “ |\ ‘\| I \h L
ki ”n\ | /| \H W \'\' ik
-103.95 dBm ‘
Autoscale | i
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Searching Signals

The RSA6100B Series Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers let you search the
Spectrum display's trace results for changes in power level. You can identify matches crossing a power level or you can
create a mask that specifies power level and frequency range limits. You can select which trace to search and specify an
action to take when a search match occurs. Pass/Fail results from the Spurious and Settling Time measurements are also

searchable, but we will use the Spectrum trace example here.

To search a trace:

1. Open the Spectrum display or select the
Spectrum display if it is already open.

2. Select Tools > Search.

3. Select the Enable Search check box.

4. Select the trace you wish to search from
the Search in drop-down list box.

5. Verify that the trace you selected in the
Search in list is the selected trace and
that the Show box is checked.

Tek RSAS1004 - [Spectrumn]
File View Run
5] ® & T & & I8 | Frequency: 15000 GHz

Window  Help
Reflev: 0.00 dBm
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F X
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- REW:
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| Clear ‘
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\
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6. Specify what to search for by making a (£ T s
selection from the Search for drop-down Bl View Run Reply Makes Sep Took  Window  Help & x
f = § & £ A Frequency: 190000 GHz Reflev: 0.00 dBm Preset Repla Sto -
lst. == ﬁi‘érr:c-a; iIShnw jPeakyNnrma\ = . |pc\ﬂ/
To search for signal levels above or © 0,00 cEm
below a specified level, select either is g
greater than or is less than. e
To search for signal levels that vary with -
frequency, select either is outside mask
or is inside mask. To specify the limits
in the search mask, click the Edit limits o e
button. Search Defie [actons @
The orange shaded area in the graph —
display shows the levels which, if i Seach i [Specinum: Trace 1 a)
occupied by the signal, will constitute a Seatch fr 20,00 dem
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i 6 ) 283804
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Display with outside mask search selected
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1.

10.

Click the Actions tab to specify what
actions the analyzer should take when a
match occurs.

The analyzer can take up to five actions
when a match occurs, depending on the
run mode. In Run mode, the analyzer
can sound a beep, stop acquisitions,
save acquisition data, save trace data,
and save a picture of the display. In
Replay mode, it can sound a beep and
stop analyzing.

To have the analyzer take an action
when a match occurs, select the desired
action.

You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

Click the close box to remove the Search
control panel.

Press the Run button to initiate a search.

Red lines appear in the graph display
when there is a match on incoming data.
Click the Replay button on the toolbar
to initiate a search on the current data
record.
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' Trace 1 V| Show  +Peak Avg 20 | \?é?‘

WBW:

& Span: 40.00 MHz

2838-060
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Using Correction Tables

The RSA6100B Series Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers let you correct the
signal displays and measurement results to account for gains and losses in external equipment. You can specify a single
gain value or you can use an external loss table to adjust the gain/loss value based on frequency.

To specify external gain/loss corrections:

1. Press the Amplitude icon button to
display the Amplitude control panel.
File  Wiew Run  FReplay IMarkers Setup Tools Window Help 5 x
2. Select the External Gain/Loss B S $ @ T = 218 Feqenc: LameHz  Reflew: 000 dém O @ ey - [Dwp -
COrrection tab v Trare1 [YIShow +Peak Normal ‘C\EE
© 0.00 dem
o dBfdiv:
10.0 dB
o RBW:
200 joiz
WEW:
-100.00 dBm
| Autoscale | = CF: 1.90000 GHe © Span: 25.00 MHz
Amplitude Internal Settings | External Gain/Loss Correction | External Probe Correction “
External Loss Tables (Loss = 0, Gain < 0)
External Gain value: 0.0 dB
Ext Loss Table 1 | Edit.. |
Apply external corrections to:
All acquired data (filter mathod) Ext Loss Table 2 | Edit... ‘
o P e R Ext Loss Table 3 [Edr..
2838047
3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box. arplitude Intern|| Settings | External GainjLoss Corection | Extemal Frobe Correction
NOTE. You can enter either positive or 7] Extermd Gan vdus: 0.0 0B Extemal Loss Tabes (Loss > 0, Gan < 0)
X . o Ext Loss Table 1 | Edt.. |
negative gain values. Positive values Apply external comections to; — =
i A . it Loss Table Edit...
represent a gain. Negative values represent e ats e et
a IOSS (see Lser r\?apnua\ fior Iis’i) i Ext Loss Table 3 \L‘
2833042
4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables. Amplitude [ mternal Settlﬂgs‘ External GainfLoss Correction | Extern:| Probe Correction |
You can enable all three external loss o B et o0 & Extemal Loss Tables (Loss > 0, Gn < 0)
tableg at the same time. Thus, you could ol externd conections 1o [ ExtLoss Table 1 (L. ]
use different external loss tables for an all acquired ciata (fiter method) O [Ext Loss Table 2 [ Edt. |
antenna, a preamplifier, and for cabling. o s | [Ext Loss Table'3 =T
2833043

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.
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6. Edit the contents of the table to match
the loss characteristics of the equipment
you are correcting for. Click OK when
you are finished.

NOTE. You can enter either positive or
negative values into the table. But in contrast
to the External Gain value setting, positive
values represent a loss and negative values
represent a gain.

For detailed information on using the Table
Editor, select Help > User Manual and look
in the Index for External Loss Tables.

7. You can change the title for each external
loss table. Select the title box and type
in a new title.

Note that the title is only a label. It is
not tied to the file name of any table you
have loaded or saved.

8. Specify whether table corrections are
applied to all acquired data or only to
traces in the Spectrum, Spectrogram,
Spurious and Amplitude vs Time
displays.

Corrections applied to data are
performed in real time using the digital
filter capabilities of the instrument. While
this has the advantage of correcting
the data for use in all measurements,
digital filtering is limited in its ability to
apply corrections that change rapidly in
amplitude over small frequency ranges,
as may occur when switching between
two antennas. When this happens,
the filters may result in an amplitude
correction that appears to ring in its
response, resulting in poorly corrected
data. For that reason, the RSA offers
trace-only correction for spectrograms,
spectrum, spurious, and amplitude vs.
time displays. These trace corrections
are similar to those applied in traditional
spectrum analyzers, and should be
used when discontinuities occur in the
amplitude/frequency correction table.

o/ Table Editor - ExtLoss Table 1 (=% ECR =<=|
| add Pt | Delete Unda X Frequency ¥ Loss [Atten)
914.0000 MHz -2.000000 dg
Frequency Interpolation
@ Linear 926.0000 MHz -2.000000 dB
Log (affects only
Trace Carrection)
New Table ‘ Load... ‘ Save As... ‘ | Apply | ‘ Ok ‘ ‘ Cancel ‘
File ‘iew Run Replsy Markers Setup Tools Window Help & x
=] & & T % N [[A Frequency: Lo00006Hz  Reflew: 0.00 dBm Bres) | O Reply O step -
v Trace 1 J]show +Peak Normal |Clear |
© 0.00 dBm
o dBfdiv:
10.0 dB
= RBW:
200 itz
WBW:
-100.00 dBrn
| Autoscale & CF: 1.90000 GHz o Span; 25.00 MHz
Amplitude Intermal Settings ‘ External GainjLoss Correction ‘Extmnal Probe Carrection ’ |
‘ ‘ : 0B External Loss Tables (Loss » 0, Gain < 0) @
External Gain value: 0.
[¥]  Antenna Edit.
Apply external corrections to:
All acquired data (filter method) ¥ Preamp \L}
5 Tracesin applicable displays 7 .
@ (see User Manual for list) ‘ Cahing \Ed#]

@ 2838044
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When choosing whether to correct
sample data or traces, keep the following
in mind:

B |f sample data is acquired while
data correction is enabled, that data
record is permanently corrected. If the
acquisition is saved and recalled, the
recalled acquisition includes corrections.
Corrections are not saved separately
from the raw data; they are used during
the acquisition process to adjust the data
values.

m  Trace corrections can be applied
at any time, as they are part of the
measurement's computations. Using
Replay will apply trace corrections to
a trace if this control is enabled (and
an external loss table is specified and
enabled).

B Be aware that if you recall acquisition
data that was saved with data corrections
and you use Replay with trace
corrections selected and an external
loss table enabled, the trace will be
calculated using corrected data and also
corrected with trace corrections. This
usually creates incorrect traces.

9. Click the close box to remove the
Amplitude control panel when you are
finished making changes.
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Using Audio Demodulation

The RSA6100B Series Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers can demodulate
audio signals, which can help you to identify unknown radio signals. You access the Audio Demod tab from the Settings

control panel of the DPX Spectrum plot display.

To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX display will open.

5. If necessary, select the Spectrum plot
from the drop-down list.

6. Press the Settings front-panel button to
display the DPX Settings control panel.

7. Click the Audio Demod tab to display
the Audio Demod control panel.

64

Select Displays

Available displays:

Choose any \:Umbina@w, or Use an Appl@

BN E=R 55

eset. Application Presets. ..

H

GP Digital Moculation = -

RF Megasurements Amplituce vs P Frequency  Phase vs
OFDM &nalysis Time ws Time Time
Pulsed RF
Audio Analysis N

RF I2Qvs Spectrogram  Time
Time Owerview
Selected displays:
Spectrum
4 Remove

o] o=

2838080

Tek RSA6100B - [DPX Spectrum]

Spectrum  «

(E=N [Eol ==
File Wiew Run  Replay Markers Setup  Tools  Window  Help a %
S} E’P T & &% A | Frequency: 488,20 MHz Reflev: 0,00 dBm Presetl | @ Replay  ~ | ) Run -
¥ Btmap  [¥]Show File:DPX Pulsed Clear
© 0,00 dBm
o dBfdiv:
10.0 dB
- RBW:
100 kHz

s § om——

-100,00 dem
Autoscale | © Pos: 488.28 MHz o Scale; 10,00 MHz
DP¥ Settings | Freq & Span| BW | Traces | Horiz & Vert Scals | Bitmap Seale | Prafs | Density | Audio Demad
. Tune with: |Selected Marker -
ot an AM
Spectrum - Audio Receiver Freq:  488.2 MHz
off M . 30.000 kH
o Receiver BW! iz
gz;i‘ré * Sound level is also affected by windows volurme contral
2638079
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8. Click the On button to enable audio

demodulation. 7
DPX Settings Freq 8 St inl BW | Traces | Horiz & Vert Scale I Bitmap Scale | Prefs | Density ‘ Audio Demod ‘
9. To specify the demodulation type, click . Tune with: [Selected Marker_~
either the AM or FM button. e o rﬂ sudo Recehver Froq:  OLS Mz
ain™®
NOTE. Note that the AM and FM buttons o 5 E Recetvr sw: 00012

Se/eCt Only the demOdU/atlon type, they dO gz;;-‘vtes * Sound lejvel is also affected by Windaws volume contral,
not specify a frequency band.

2838045

(=

10. Set the center frequency as needed.

Ihed rece(ijve|r frz?uency (ffre?juenﬁy t(?] DPX Settings | Freo & Span| BW | Trames | Honie & wert Srale | Bitman Scals |Pr;fs_ I mtyﬂjlwinod_ .

e demodulated) is specified with either =

markers or the frequency control (the [ZI;ZEUTJ on e A [;m W'th ;;;;[egsmm }
front panel Frequency button or the Freq or Gen® T T T
control in the toolbar). Use the Tune with - = R
setting to specify whether markers or the | Seit | " Sound v & d afected iy W vfreg conrdl_
frequency control is used to specify the e
receiver frequency.

11. Select either a marker or frequency
control from the Tune with drop-down
list.

12. If the marker you select is not enabled R TR el=le
(it will be visible in the display if it is e Ve Bn Byl MRS GRS T G :
enabled), click the Markers iconMarkers LIE U £ 3oL o L oty C1OM -
button in the toolbar to display the comen B il —_
Markers toolbar. o&lEm

o RBW!
160 &z

Spectrumn -

I

-100.00 dBm
Autoscale © Pos: 488,28 MHz © Scale: 10,00 MHz
DP¥ Settings | Freq & Span | BW | Traces | Hariz & Vert Scale | Bitmap Scale [ Prefs | Density | Audio Demod

&)

Flot: Ture with: | Marker MR -
M O — Audio Receiver Freq; 483,275 MHz

Gain*
S Recaiver Bw;  30.000 kHz

Restore "
Defaults Sound level is also affected by Windows volume control.

0
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13. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

14. Click Add to add markers as needed.

15. Click the Settings button to return to the
Audio Demod control panel.

16. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.

66

@

Define Markers | Marker Properties | Define Peaks

Reference Delta Markers

Add Marker: MR

Attach to: Tracel =
Delete {in selected
display)

Readouts: | Delta -
Al off
me—] > > 5m o conter ] [(pedc] (] (2]

i

i

Markers Defe |+~ MR

e ]

2838062

TR Tek RSA61008 - [P Spectrum] =Ei=]
File Wiew JRun  Replay Markers Setup  Tools  Window  Help J x

5] T % % [N | Frequency: 49820 MHz  Reflev: 0,00 dBm sl @ Reply - [DRun -

#  Bitmap  [¥]Show File:DPX Pulsed Clear

© 0,00 dBm
o dB/div

10.0 d&
o REW:

100 kHz

Spectrum v

-100.00 dBm
Autoscale 9

Define Markers | Marker Properties | Define Peaks

Reference Delta Markers
Add Marker:
Attach to:
Delete (in selected

display)

Readouts: | Delta ~
all off
Markers w aloff |Frequency To Center Peak

£330

2838077

DPYX Settings | Freq & Span| Bw | Traces | Horiz & vert Scale | Bitmap Scale | Prefs | Density | Audio Demod

Tune with;  |Marker MR -
on ‘ AM

Audio Receiver Freq: 91.5 MHz

Gain*
off
=

Flot:

[E‘mectrum vJ

Recefver gyy; 90000 kHz

kL

* Sound level is also affected by Windows valume cojitrol,

@ -

Restore
Defaults
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17. Set the receiver frequency.

If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. Fine tune the marker
position with the front-panel knob or
your mouse wheel. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.

The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

18. Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the

setting of the Windows volume control.

Operation

Tek RSAGL00E - [DPX Spectrum]

[E=2E=H 55
File View Run  Replay Markers  Setup Tools  indow  Help 5 x
=] T & & 18, | Frequency: 489.20 MHz Reflew 0.00 dBm PR | @ Replay - |DRun -
v Bitmap  [V1Show File:DPX Pulsed Clear
© 0,00 dém
« dBfdiv:
10,08
o RBW:
100 k2

Spectrum |

-100.00 dBm

Autoscale < Pos: 488.28 MHz

& Scale: 10,00 MHz

CPX Settings

Freq & Span| B | Traces | Horiz & vert Scale | Bitmap Scae | Prefs | Density | Audio Demod

= -
— on
Spectrum v Audio
Gain™*
off
- =
Restore
Defalts /\

AW

™

k|

* Sound level is also affected by Windows vaolume contral,

Tune with: Warker MR v

Receiver Freq:  488.2 MHz

Rereiver Byy:  0.000 ki

Markers [ Define | ~ MR \ Iéncv +|488.2 MHe
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Application presets, 30
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Touchscreen actions menu, 40
check mark indicator, 24, 54
Cleaning procedures, 15
Conflicts

measurement, 55
Connectors

front panel, 21

rear panel, 22

RF signal input, 34, 35
Controlling acquisitions, 54
Controls

display-specific, 25

front panel, 17

interface, 23
Cooling clearances, 7
correction tables, 61

D

Data

recalling, 45

saving, 44
Default settings, 33
Diagnostics, 14
Digital demodulation displays, 28
Display

conflicts, 55

Display properties
changing, 13
Display settings
changing, 32
Displays
general signal viewing, 28
GP digital modulation, 28
printing, 42
Pulsed RF, 28
RF measurement, 28
selecting, 29
Documentation, x
Tektronix part numbers, 1,3
DPX Density
triggering, 47

E

Environmental specifications, 7
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cooling clearances, 7
humidity, 7
temperature, 7
Extended desktop, 10
external gain/loss correction, 61
External monitor, 10

F

Features, ix

File types, 44

Free Run trigger mode, 47
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triggering, 47
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Mask Editor, 51
triggering, 48

Front panel
connectors, 21
controls, 17

G
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Graphics driver, 13

Incoming inspection, 14
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Input requirements
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Installation, 1
network connections, 8
Italicized numbers, 25
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Key features, ix
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Marker toolbar, 39
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delta, 38
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Mask Editor
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conflicts, 55
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Messages
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Network connections, 8
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Touchscreen actions menu, 40
Part numbers, manuals, 1, 3
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Power level triggering, 48
Power supply, 7
Preset, 33

selecting displays, 30

system settings, 33
Printing, 42

ink saver mode, 43
Product features, ix
Pulsed RF displays, 28

R

Real-Time spectrum analyzer, 26
Rear panel connectors, 22
Recalling data, 45
Repackaging, 15
Reset scale

Touchscreen actions menu, 40
Returning the instrument, 15
RF input connectors

RSA6100B series, 2
RF measurement displays, 28
RF signal connections, 34, 35
RF signal input range, 34
Run control, 36
Run menu, 36
Runt triggering, 48

S

Safety Summary, iii
Save options, 44
Saving data, 44
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Screens, printing, 42
Search, 58
Select
Touchscreen actions menu, 40
Selected window, 54
Selecting displays, 29
Settings
changing, 32
default, 33
preset, 33
Setups
recalling, 45
saving, 44
Software upgrades, x
installing, 15
Span Zoom
Touchscreen actions menu, 40
Specifications
altitude, 7
cooling clearances, 7
environmental, 7
humidity, 7
input requirements, 34
mechanical, 7
power supply, 7
product dimensions, 7
temperature, 7
Spectrum analyzer
real-time concepts, 26
Standard accessories, 1,3
documents, 1
power cord, 2,3
Product Documentation, 3
Starting acquisitions, 35
Stopping acquisitions, 35

.

Time Qualified
triggering, 47
touchscreen actions menu, 40
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Trigger
control panel, 49
mask, 51
violations, 54
Trigger Event parameters, 48
accessing, 49
Triggered trigger mode, 47
Triggering
DPX Density, 47
free run, 47
frequency edge, 48
frequency mask, 47
parameters, 48
power level, 48
Runt, 48
time qualified, 47
triggered mode, 47

U

Upgrades
software, Xx, 15

vV

Violations
trigger mask, 54

w

Window
analysis, 26
selected, 54

V4

Zoom
Touchscreen actions menu, 40
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